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Pin Mapping

Before Getting Started
Visualization of point locations directly from database materials is a very
powerful tool in TNTmips® and TNTview®, particularly when the information is
frequently changed. Each location mapped can be represented as a simple point,
a symbol, or as a pie chart or bar graph.  Databases for pinmaps can be in
TNTmips’ internal format or in some external format supported by direct linking
or Open Database Connectivity (ODBC).  Any table that contains X and Y
coordinate fields for each record can be used for pin mapping.

Prerequisite Skills  This booklet assumes you have completed the exercises in the
Displaying Geospatial Data and Navigating tutorials.  Those exercises introduce
essential skills and basic techniques that are not covered again here.  Please
consult these booklets for any review you need.

Sample Data  The exercises presented in this booklet use sample data distributed
with the TNT products.  If you do not have access to a TNT products CD, you can
download the data from MicroImages’ web site. The exercises in this booklet use
objects in the GSPINMAP and UNTDSTAT Project Files in the PINMAP directory of
LITEDATA.  Objects in  Project Files in the CB_DATA directory are also used.  Make
a read-write copy on your hard drive of the sample data so display parameters can
be saved when you use these objects.

More Documentation  This booklet is intended only as an introduction to pin
mapping.  Consult the TNTmips reference manual for more information.

TNTmips and TNTlite™  TNTmips comes in two versions: the professional
version and the free TNTlite version.  This booklet refers to both versions as
“TNTmips.”  If you did not purchase the professional version (which requires a
software license key), TNTmips operates in TNTlite mode, which limits the size
of your project materials.

Pin Mapping is available in TNTmips, TNTedit,  and TNTview.  Pinmaps can be
used with TNTatlas, but they can’t be created while running one.  All exercises
in this booklet can be completed in TNTlite using the sample geodata provided.

It may be difficult to identify the important points in some illustrations without a
color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source of the newest Getting
Started booklets on other topics.  You can download an installation guide,
sample data, and the latest version of TNTlite.

http://www.microimages.com

Merri P. Skrdla, Ph.D., 1 November 2002
© MicroImages, Inc., 2002
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Welcome to Database Pin Mapping
The ability to visualize database information di-
rectly  is a very powerful tool—it means the informa-
tion can be updated as often as needed, even during
the display process, and the updated locations and
information can be viewed immediately.  Because
TNTmips supports ODBC, as well as direct linking
to dBASE IV, FoxPro, and the ARC/INFO database
format, you can manipulate databases in their native
software and view the updated results in the TNT
products without any additional steps.  Any table
that contains X and Y coordinate fields for each
record can be used for pin mapping.

The point locations in the database table
can be represented in a variety of ways:
as  symbols or as open or filled boxes or
circles.  The symbols can be from the
standard set that comes with the TNT
products or symbols you design yourself
using the Symbol Editor, which is accessible in
any process that lets you assign symbols for display.
You can also create pie charts or bar graphs that
represent the relative values for several attributes at
the point location.

Even with elaborate symbols selected to mark point
locations, you generally need a reference layer to
provide a context for your pin map.  The reference
layer can be any TNTmips object type, such as
satellite imagery, an airphoto, or vector polygons.

There are two parts to a pinmap: the graphic depic-
tion of the point locations and the other associated
information in the database table.  You can view the
database records for the pinmap as single records or
in tabular form.  When using the tabular view, you
can choose to see all records or only the records
related to currently selected pins.  You can also
update the information for existing pins or add
records that will place new pins on the map.  These
changes are immediately reflected in the display.

launch TNTmips

copy the sample data files
for this booklet to your
hard drive

select Display / Spatial
Data from the main menu
and open a new 2D Group

click on the Prefer-
ences icon, choose
View Options,  and
turn on the first option on
the View tabbed panel
(Redraw after any change)

STEPS

Vocabulary: A database
pinmap is a visualization of
a number of point locations
represented by spatial
coordinates in a database
table.  The pinmap derives
its name from the wall-
mounted counterpart where
pins in a map represent
points of  interest.

Pages 4–10 provide instruc-
tion for relatively simple pin
maps.  The remaining
exercises take you through
more complex pin mapping
concepts, such as pie
charts and bar graphs, label
positioning, and pin
selection.
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Simplest Possible Pinmap
You can create a pinmap without entering any query
statements if coordinates are present in a usable
format.  You can also get by without selecting a style
object if you will accept one of the six default
drawing styles.  Such a pinmap isn’t much to look at,
see lower left, but it does provide access to the

STEPS
click on the Add
Database Pinmap
icon and select
GEOCHEM_CB from the
GSPINMAP Project File

click on the Symbol tab,
then on [Style] to the right
of the Symbol option
menu

click on the red tile in the
color palette, then click
[OK]

click on the Points tab,
then click on [X], and
double-click on X in the
list of the new window

click on [Y], then double-
click on Y in the new
window’s list

click on [Projection], then
on [System] in the new
window and double-click
on Universal Transverse
Mercator

if some other zone is
shown, click on [Zone]
and select 13

click [OK] in the
Projection window and
[OK] in the Pinmap Layer
Controls window

click on the Add
Vector icon, choose
Quick-Add Vector, select
HYDROLOGY from the CB_DLG

Project File in the CB_DATA

data collection

A reference layer is almost
necessary with pinmap display
to provide a context for what
you are viewing.

database informa-
tion by location.

pinmap
without
reference
layer
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Coordinate Formats and Symbols
The format in which Latitude / Longitude coordi-
nates are expressed must be designated.  TNTmips
supports 25 different formats.  Select the format used
from the option menu on the Points panel (for the
CAPITALS database, millionths of a degree).  If de-
grees, minutes, and seconds are expressed in sepa-
rate fields, you can convert the coordinates to a
usable format with a script.

A style object is a collection of drawing specifica-
tions for vector, CAD, TIN, and pinmap objects.
These specifications include such factors as color,
size, and assignment of symbolic representation.
Symbols, line patterns, and fill patterns are also
stored in style objects.  You need to select a style
object before symbols become an option for the All
Same drawing style.

STEPS
delete added layers

click on the Add
Vector icon, choose
Quick-Add Vector, and
select STATES from the
UNTDSTAT Project File

click on the Add
Database Pinmap
icon and select the
CAPITALS object from the
GSPINMAP Project File

click on [Styles] and
select STARS from the
SYMBOLS folder in the
STDSTYLE Project File*

on the Symbol panel,
click on [Style] to the right
of the Symbol option
menu

set the Point Type option
menu to Point Symbol

scroll through the list of
symbols until
you find
STARRED3D,
click on it, then
click [OK]

check that the
projection on
the Points
panel is
Latitude /
Longitude

set the X field
to LONG, the Y field to
LAT, and the format to
DDDdddddd

click [OK] in the Pinmap
Layer  Controls

click on the Save
Group icon and
create a STATECAP group
object in your GSPINMAP

Project File
* For future reference
if you did a  complete install,
STDSTYLE.RVC will also be in the directory on your
drive where the TNTmips executables are found.
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Selection and Style By Script
Record selection, symbol assignment, labels, and
coordinates can all be specified in a single script.
The corresponding option also must be set to By
Script for the relevant query statements to be used,
as shown by the initial display in this exercise.  The
“return” statement at the end of the script means that
only those records with a FREQUENCY greater than 19
will be displayed when the record selection method
is set to By Script.

You can specify drawing color using any color
name found in the RGB.TXT reference file or by
supplying percent red, green, and blue (separated by
spaces).  In either case the color specification in the
DrawColor$ = statement must be in quotes.  If shape
and size are not specified in the query, the last
settings for All Same are used.

STEPS
choose Group /
Close then click on
the New 2D Group icon

click on the Add
Database Pinmap
icon and select the
ARTIFACTS object* from the
GSPINMAP Project File

click on the Symbol tab,
click on [Style] (to the right
of the Symbol option
menu), and set the Point
Type to Circle (filled)

click on [OK] in the Point
Style Editor window, then
set the Symbol option
menu to By Script

click on the Points tab,
click on [X…], then double-
click on EASTING

click on [Y…], then double-
click on NORTHING

click on [Projection…] and
select UTM Zone 16

click on the Script tab and,
in the Query Specification
field, type the text exactly
as below

return to the Pinmap Layer
Controls window, click on
the Object tab, and set the
Records option to By
Script

click [OK]

if (DATABASE.FREQUENCY > 39)
   DrawColor$ = "cornflower blue";
else
   DrawColor$ = "sea green";
return DATABASE.FREQUENCY > 19

* The points in the
ARTIFACTS object
represent a subset
of the data
collected for the
Sayil Archeological
Project (Michael
P. Smyth and
Christopher D.
Dore,
Principal
Investigators).
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Symbols and Size By Script
You can specify a symbol from a selected style
object either by the symbol name or the style name.
If the symbol in question uses elements of variable
color, the actual color is specified by the style if a
style is selected or by the color last chosen for
symbol display if only a symbol name is specified.

You need to include scaling information in the query
if you specify the symbol by its name.  Scale infor-
mation is included as part of the style definition and,
therefore, need not be in the script if a style name is
specified.  The script in this exercise uses one of the
field values to determine the scale so that locations
where a greater number of artifacts were found are
represented by larger symbols.

The symbol name must be entered exactly as it
appears in the style object.  In situations where you

STEPS
return to the Pinmap
Layer Controls window
and click on [Styles] on
the Object panel

select the STYLECERAMIC

object from the GSPINMAP

Project File

click on the Symbol tab
and click on [Style] at the
right of the Symbol option
menu

click on the red tile in the
color palette then on [OK]

choose Query / New on
the Script panel and type
in the text exactly as
below

click [OK], and observe
the style, distribution, and
size of symbols

return to the Pinmap
Layer Controls window

click on [Style] in the
Symbol panel

click on the blue tile in the
color palette then on [OK]

click [OK] in the Pinmap
Layer Controls window

Symbol$ = "ceramic";
XScale = (DATABASE.FREQUENCY / 50);
YScale = XScale;
DrawSymbol = 1;
return (DATABASE.FREQUENCY >= 25)

are not sure of a name or its capitaliza-
tion, set the Symbol option menu to All
Same and click on the Specify button*.
Then set the Point Type to Point Sym-
bol (this choice is not active if you don’t
have a style object selected), and check the list to the
right of the color palette.  Remember to set the
Symbol option back to By Script.

* Assigning a style in a
script requires you to be
even more familiar with the
style object because, at
this point, you have direct
access only to the list of
symbols.
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Symbol Angle and Multiple Pins
STEPS

choose Group / Close
then click on the
Open  icon in the
Spatial Data Display
toolbar, choose Open
Group and select the
SCHOOLS group from the
GSPINMAP Project File

click on the Add
Database Pinmap
icon, and select the
SCHOOLS object from the
GSPINMAP Project File

click on the Symbol tab
and set the Symbol option
menu to By Script

type the text exactly as at
the right on the Script
panel in the Query
Specification field

click [OK]

repeat steps 2 and 3, then
change the query so
DrawColor$ = “Green”
Angle = 0 and XScale =
Mayors_Run._1996 / 10

click [OK]

repeat steps 2 and 3, then
change the query so
DrawColor$ = “Blue”
Angle = 310 and
XScale =
Mayors_Run._1997 / 10

click [OK]

Each database record can produce only one pin in
the pinmap, so to look at information for one loca-
tion on several dates, you need to have multiple
pinmap layers, each with a different drawing style
(or you could use a pie chart or bar graph, which are
described later in this booklet, if that seems appro-
priate).  To prevent pins in different layers from
obscuring one another, assign a different angle to the
symbols used in each layer.

This exercise maps the number of participants from
each of seven schools in a 1-mile foot race in three
successive years.  The years are distinguished both
by pin angle and color (all red pins, which are also
rotated 50° counter clockwise, represent the 1995
participants).  The size of each pin is determined by

the number of run-
ners from the school
located at the point
of the pin.  When
pinmap locations
are represented by

The same database object
appears four times in this
group, once to identify school
locations with a representative
symbol, and once for each
year in which race participation
is being mapped.

Symbol$ = "MapPinN2";
DrawColor$ = “Red”;
Angle = 50;
DrawSymbol = 1;
XScale = Mayors_Run._1995 / 10;
YScale = XScale;
MapScale = 40000

symbols, the “hot spot” is placed at the coordinate
location.    For many symbols, such as those on the
preceding pages, the hot spot is in the center of the
symbol.  For these map pin symbols, the pin point is
a more logical choice.
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Simple Labels
You can use the value of any field in the database to
label the pins.  You can also enter a query to generate
the labels.  The default position for labels is to the
right of the pin.  You can, however, position labels
wherever you want around the pin using the option
menu on the Symbol panel.

You need to add the labels to only one of the database
pinmap layers in this example since the pins repre-
sent the same location in each layer.  You can,
however, have labels in different layers at different
sizes if you choose.  More advanced labeling fea-

STEPS
click on the Data-
base Pinmap icon in
the layer icon row for the
bottom pinmap layer

click on the Symbol tab,
then on [Label], and
double click on School in
the Label window

Click on tiles in the
color palettes to set
the text color.

click on [Base Style], then
on [Font] in the Text Style
Editor window, and
double click on Arial.ttf (or
a similar font)

set the Ascender Height
to 12 Points at a map
scale of 40000 with the
Scale set to User-Defined

click on a blue tile for the
Foreground Color and a
white tile for the
Background Color

click on the Enhanced
check button to the right
of the color palettes, then
click [OK] in the Text
Style Editor window

set the Label Position to
Lower Center then click
[OK] in the Pinmap Layer
Controls window

Select the
font from the
scrolling list
that opens.

Set the character
style by clicking on
one or more of these
choices (some are
mutually exclusive).

tures are described in the later
exercises (Multiple Line La-
bels and More About Label-
ing).

Use of
enhanced
text helps to
ensure that
labels will be
visible
whether the
local back-
ground is
dark or light.
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Dynamic Update
STEPS

choose Group /
Close then click on
New 2D Group

click on the Add
Database Pinmap
icon and select the
GEOCHEM_CB object

check that the settings are
still the same as for the
exercise on page 4

click on the [Style] button
on the Symbol panel and
choose Circle (Filled) for
the Point Type

click on [OK] in the Point
Style Editor and in the
Pinmap Layer Controls

click on the Show Details
icon for the
pinmap layer
then on the Show
Tables icon

click on the View
Table icon for the
Geochemistry table

in the new record, enter
the information shown
above the center pinmap

choose Record / New and
enter the information
shown over the pinmap on
the right, then choose
Table / Close

You can update your pinmap during display by
adding new records or changing existing records.
When coordinates are changed, the pins are moved.
These changes can be made during the display
process, or if the database is in an external format,
using its native software.  During display, changes
are apparent as soon as the database is updated by
selecting another record or closing the table.

When you open a table in single record view with no
points selected, the table is automatically positioned
at a new record.  You then simply enter the informa-
tion for the new record.  You need to take some
action that indicates you are done with the record,
such as closing the table or selecting another pin,
before the new pin is drawn.

ObsNum: 11
X: 640759.83
Y: 4731825.48

Cu: 87
Pb: 627
Zn: 429

ObsNum: 12
X: 642763.89
Y: 4729854.62

Cu: 117
Pb: 414
Zn: 658

11

12

If your table
opens
showing
rows and
columns
instead of
appearing
as at the

left, choose Switch to Single
Record View from the Table menu
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Pie Charts
STEPS

click on the Database
Pinmap icon in the layers
icon row

choose By Script from the
Symbol option menu

click on the Script tab and
enter the query as below,
then click [OK]

click on the Add Raster
icon, choose Quick-Add
Single and select _8_BIT

from the CB_COMP Project
File in the CB_DATA

collection

click on the Change
Order icon and
choose Lower

Special query statements are available so you can
create pie charts and bar graphs to represent each
data location.  These special symbols can incorpo-
rate values from as many different fields as desired.
We will display over a raster object for this pie chart
sample exercise.  An outline around the pie and
between the wedges is an optional component of a
pie chart so the background is relevant when choos-
ing its color.  The color to use for this outline is

Symbol$ = PieChart$(“white”, Geochemistry.Cu,
                  Geochemistry.Pb, Geochemistry.Zn);
DrawSymbol = 1;
XScale = 5;
YScale = 5;
MapScale = 125000

indicated at the beginning of the
pie chart specification (here, it is
“white”).  If a color name is omit-
ted here, there will be no outline.

You can add as many of the fields
as you want to a pie chart and the proportion of each
to the whole for that location will be reflected in the
relative size of the wedges.  The default colors
assigned counterclockwise in order from the origin
are red, green, blue, cyan, magenta, yellow, and then
repeating if you have more than six fields.  You can
also specify the color for each wedge if desired
(consult the reference manual).

You are instructed to type
all the queries in this
booklet to match the ex-
ample provided.  You
can, alternatively, use the
Insert menu choices to
add most of the compo-
nents of a query.  Using
the Insert menu to build
queries is described in an-
other booklet in this se-
ries (Getting Started:
Building and Using Que-
ries).

Lead accounted for nearly half of the
dissolved chemicals found at the location
represented by this pie chart.
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click on the Add
Vector icon, choose
Quick-Add Vector, and
select HYDROLOGY from the
CB_DLG Project File

click on the Remove icon
in the layer icon row for
the  _8_BIT raster object
and choose Remove
Layer

click on the Database
Pinmap icon for
GEOCHEM_CB and replace
the pie chart script with
the following

click on [OK]

Bar Graphs
The query to specify a bar graph is more complex
than that for a pie chart; a pie chart requires only the
symbol type, the fields to be included, and a size at
a specified map scale.  For a bar graph you also need
to specify information for the surrounding rect-
angle, which is really two rectangles (one white and
filled, the other black and unfilled), the baseline (if
you want one), and the field value equivalent to the
rectangle height.

You can include as many fields as you like in the bar
graph; the bars become narrower as more are in-
cluded.  You change the overall width of the bar
graph using the XScale parameter in the query.  As
with pie charts, the color of the bars can be omitted

STEPS

Symbol$ =
Rectangle$(0,0,1000,1000,0,"white",1) +
Rectangle$(0,0,1000,1000,0,"black",0) +
BarGraph$(
  750,
  "black",
  Geochemistry.Pb, "blue",
  Geochemistry.Zn, "green",
  Geochemistry.Cu, "red"
) +
Line$(-100,0,1100,0,"black");
DrawSymbol = 1;
XScale = 5;
YScale = 7.5;
MapScale = 125000

from the query and then are automati-
cally assigned in the order red, green,
blue, cyan, magenta, yellow.

The first value in the BarGraph$ portion
of the script sets the rectangle height,
here 750.  The color name that follows
the rectangle height is for the bar outline
if desired.  The baseline length is deter-
mined by the Line$ part of the script and
is relative to the rectangle coordinates
such that Line$(-100,0,1100,0, “black”)

These bar graph
symbols present
values for the
same fields but in
a different order
than in the pie
chart exercise.

specifies a black line that
extends 10% of the width
beyond a 1000 x 1000 rect-
angle both to the right and
left.

Approximately equal concen-
trations of lead and zinc were
found at the location represen-
ted by this bar graph.
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Better Understanding Bar Graphs
Let's change a number of bar graph parameters so
you can see how each works.  The one part of the bar
graph script you should not change is the size speci-
fied for the bounding rectangles.  The bar graph itself
is scaled so the bars for all fields listed in the query
fit in a width of 1000 and the maximum field value
specified is represented by a height of 1000.  The
units are arbitrary and used only so that the bounding
rectangles can fit the graph.  The actual dimensions
of the bar graph are controlled by the XScale and
YScale assignments and the map scale specified.  If
you change the width of the rectangle, the width of
the bar graph will exceed or fall short of the width of
the rectangle.  If you change the height of the
rectangle, the maximum field value specified will
not occur at the top of the rectangle.

The bar graphs that correspond to observation num-
bers (ObsNum) 3 and 10 are used for the illustrations
on this page.  All of your bar graph symbols will
change in a similar fashion since the script applies to
all pins.  Your sample data is not set up for the last
two examples, which include five additional fields
without color specification in the bar graph query.
As you can see below, adding more fields with the
same XScale specified makes each bar narrower.

STEPS
click on the Database
Pinmap  icon for
GEOCHEM_CB

change the YScale in the
script from 7.5 to 5

click [OK], see (1) below

click on the Database
Pinmap icon for
GEOCHEM_CB

change the YScale back
to 7.5, and change the
field value equivalent to
the rectangle height from
750 to 1750

click [OK], see (2) below

click on the Database
Pinmap icon for
GEOCHEM_CB

change the field value /
height back to 750, and
change the Line$ state-
ment from -100,0,1100,0
to -400,0,1400,0

click [OK], see (3) below

as originally
specified (1) XScale and

YScale = 5

(2) original X and Y scales
but the field value equi-
valent to the rectangle
height changed to 1750

(3) baseline
from ± 100
to ± 400

XScale and
YScale = 7.5

original speci-
fications with 5
fields added
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Multiple Line Labels
Adding simple one line labels is described in an
earlier exercise.  Some pin maps, such as pie charts
and bar graphs, benefit from multiple line labels.
The labels can include values for all of the fields
used in these special symbols or values for a subset
of these fields.  Field values can be reported with or
without identifying text.  You can also include a line

STEPS
click on the Database
Pinmap  icon for
GEOCHEM_CB

change the Line$
statement back to that
specified on page 12

add the three lines at the
right to the end of the
script exactly as shown
(there is a space between
the initial quote and the
element identifier so that
the label sits to the right
of the baseline)

on the Symbol panel, click
on [Label] and double-
click on By Script

click on [Base Style], then
click on [Font] in the Text
Style Editor window and
double click on Arial.ttf (or
a similar font)

set the Ascender Height
to 10 Points at a map
scale of 100000 with the
At Scale option set to
User-Defined

click on the black tile (or
white tile if you have a
black background) in the
Foreground palette

click [OK] in the Text
Style Editor window

click [OK] in the Pinmap
Layer Display Controls
window

exit the Display process

print (" Pb:", Geochemistry.Pb);
print (" Zn:", Geochemistry.Zn);
print (" Cu:", Geochemistry.Cu)

of text without an ac-
companying field value
if desired.  An alterna-
tive method for enter-

ing multiline labels uses the Label$ assignment
statement listed for simple labels in combination
with text, integer field identifiers, new line specifi-
cations, and field names.  Consult the reference
manual for details on this more complex method of
label assignment.

The labels report the
concentrations in parts per
million of the three chemicals in
these bar graphs.
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Pasting a Pinmap into a Vector Object
The Copy and Paste features of TNTmips’ Spatial
Data Editor let you create point elements in a vector
object from a database pinmap using the specified
coordinate fields to position the database pins you
select.  These point elements retain direct attach-
ments to the corresponding records in the table,
which becomes part of the vector’s point database.

You can choose to copy elements from the entire
object or from a designated region, which may have
been saved previously or can be drawn before copy-
ing is initiated.  You may copy either all elements or
only selected elements from the designated region.
The object you are pasting the points into must be an
active editing layer while the pinmap can be a refer-
ence layer.

STEPS
select Edit / Spatial Data
from the main menu

click on the Open
icon in the TNTmips
Object Editor window and
select HYDROLOGY from the
CB_DLG Project File

choose Add / Database
Pinmap from the
Reference menu and
select GEOCHEM_CB from
the GSPINMAP Project File,
and click [OK]

click on the Copy
icon in the Spatial
Data Editor View window,
and set the Region Type
to Entire Object

click on [Copy] in the
Copy Object window

click on the Select
icon for the HYDROLOGY

layer

click on the Paste
icon

click on [Paste] in the
Paste Placement Tool
window

click on the Save
As icon and save
the edited HYDROLOGY

object to a new file,
adding POINTS to the object
name so you can’t
confuse it with the original
HYDROLOGY object

The Paste Placement tool
appears as a box with the
extents of the copied
elements in the same position
as the originals.  Generally,
this is the correct position for
pasting because it was
determined by georeference.
You can, however, move,
resize, or rotate the box.

The original pinmap layer
has been hidden and the
point display style is set to
filled circles that are larger
than the default size.



page 16

Pin Mapping

Designing Your Own Pinmap Symbols
STEPS

launch Display / Spatial
Data with a new 2D group

click on the Add
Database Pinmap
icon and choose the
ARTIFACTS object

click on the Symbol tab,
set the Symbol option
menu to All Same, and
click on [Style]

set the Point Type to
Point Symbol

click on the New
Symbol icon then on
the Rectangle icon in
the Symbol Editor
window

click on an orange tile in
the color palette, then turn
on the Fill toggle

pull out a rectangle that
fills the bottom quarter or
third of the design area
and right-click to add it

click on a gray tile and
change the shape of the
rectangle tool to be thin,
extend to the top of the
design area, and overlap
the first rectangle, then
right click

click on the Polygon
tool

click on [Variable] and
draw a triangle as shown,
then right-click

click the Select  icon
then on the gray, thin
rectangle and next
on the Lower icon

save your work, close the
Pattern Editor window,
choose your new symbol
from the list, click [OK]
and display

You can create your own symbols in any TNTmips
display process if a style object has been specified
for the pinmap.  Since you can choose to create a new
style object in the selection process, you can design
your own symbols to be added to an existing or new
style object at any time by opening the control
window, designating a style object on the Object
panel, clicking on [Style…] on the Symbol panel,
and clicking on the New Symbol icon.  TNTmips
also has a separate Style Editor process (Edit /
Styles) that lets you design point symbols, line
patterns, and fill patterns for use with any object type
without having a specific object selected for display.

The tools used in this exercise for symbol design are
interactive.  A scripting language for precise, sym-
metric symbol design is also available.

The All Same drawing
color, which is used as
the variable color, is set
to red in this example.

design area
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Creating Symbols from TrueType Glyphs
STEPS

click on the Database
Pinmap icon in the
layer icon row

click on the Symbol tab,
then on [Style]

click on the New
Symbol icon

choose Open TrueType
Symbol from the Pattern
Menu in the Symbol Editor
window

select wingdings or some
other TrueType font

scroll until you find a
glyph you’d like to use,
click on it, then click [OK]

select each element in
turn, click on the color you
want in the palette (or
choose Variable), and
click on Fill

change the drawing order
of any element layered so
it hides another element

select the outermost
element again, choose
Copy from the Edit menu,
then choose Paste, and
click on [Apply] in the Box
Edit Controls window
(without moving the box)

click the Select  icon,
select the new outer-
most element, click on the
black color tile, and turn
off the Fill toggle if on

save your work (Pattern /
Save)

You do not have to rely on your own drawing
abilities to create pinmap symbols; you can paste and
colorize any glyph from a TrueType font.  Some
fonts contain only one element in a glyph, which
means you cannot create a multicolored symbol
without adding to the design.

Symbol elements can have one color assigned and be
either filled or unfilled.  Thus, to have an outline for

The font size set does not
affect the symbol, only the
size at which it is viewed
for selection.

a filled symbol, you need to add a
copy of the outermost element
and assign a contrasting color to it
(without filling).

Symbol elements have an assigned
drawing order that may need to be
changed when the elements are
filled.  If you fill an ele-
ment and can no longer
see another element that
should be on top of it, you
need to lower the former
element in the drawing
order.

single element
multiple

elements

Selected glyphs

The pole and the background of the flag are a single
polygon in this glyph, so they can only be assigned a
single color.  Several steps in the sequence of coloring
and outlining the flag symbol are shown above.

appear in outline.  If you
don’t see the selected glyph
in the design area, change the area’s background color.
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Table Viewing
STEPS

click on the Open
icon on the toolbar,
choose Open Group, and
select the STATECAP group
you saved on page 5

choose Options / Colors in
the View window, change
the Selected color to
green, then click [OK]

click on the Show Details
icon for the
pinmap object,
then on the Show
Tables icon

right-click on the
POPULATION table name or
description, and turn off
the Tabular View toggle

click on the View
Table icon for the
POPULATION table

click on the Toolbox
icon, then on the
Rectangle icon, and
draw a rectangle that
includes the capitals of
the northeastern states

right-click and choose
Select Elements

choose Table / Switch to
Tabular view in the
database table window

click on each of the View
icons (in the toolbar below
the Record menu), and
note the differences in
information
shown

Database tables can be displayed in either single
record or tabular view.  Each view type has its own
associated features.  There are two methods to switch
between viewing modes: right-click on the table
name to turn on / off the Tabular View toggle or
select the other viewing mode from the Table menu
in the database table viewing window.

Single record view is often easiest for data entry
because a smaller window is needed to view all
fields.  Also, for vector, CAD, and TIN objects, a
new record is created automatically when you click
on an element without a related record in a table.
Single record view, however, only presents infor-

mation about the active
element and does not
have any of the element

selection features available in
tabular view.

You have the option in tabular
view of viewing all records,
records related to all selected
elements, or only those records
related to the active element.

You can also select one or more
records and click on an icon to se-
lect all the elements related to those
records.
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You changed the highlight color for selected ele-
ments in the last exercise because the symbol used
for the pinmap is red, which means selected elements
are indistinguishable from other elements unless the
highlight color is changed from red.

You can click on pins and view the related database
information, as you did in the last exercise, or select
records and view the associated pins.  When you are
selecting pins to view related records you want to be
in either the View Active or View Selected Element
Records mode so all the records of interest will be in
view in the table.  You generally want to be in the
View All Records mode to choose records for use in
selecting pins.

You can choose to sort on any field for database
viewing purposes.  This table was initially sorted
alphabetically by capital city.  After sorting by
population and selecting as described, all capital
cities with population > 250000 should be high-
lighted.

1) click here

2) hold down the <shift> key, then
click in the last Select Record box

3) click on the
Exclusive icon

4) the checks
are replaced
by related
indicators…

…and the pins are
redrawn with selected elements in highlight

Exclusive

View All Records

View Active Element Records
View Selected Element Records

Selecting Pins
STEPS

click on the View All
Records icon

widen the Population
table so you can see the
fifth field, or column
(Pop), right -click on the
field name, and choose
Sort On This Field from
the menu that pops up

scroll down until you see
a population >250,000
and click in the Select
Record box (should be
St. Paul, MN)

scroll to the bottom of the
table (after sorting,
should be Phoenix, AZ),
hold the <shift> key and
click on the last Select
Record box

click on the Exclu-
sive icon

icons for element
selection from
selected
records
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Pinmap from Vector Database Tables
You can create a pinmap from any database table
that can be viewed in TNTmips and contains X and
Y coordinates in each record.  The table need not be
part of a main level database object; it can be part of
the point, line, or polygon database of a vector
object, for example.  You might want to represent
soil polygons by their centroids when displayed
over other polygonal data, such as watershed basins,
because multiple sets of polygon boundaries are
visually confusing.  You can, however, readily visu-
alize the number of different soil type polygons
within a watershed basin when soil polygon cen-
troids are displayed with the watershed polygons.
Usable centroid coordinates are available for any
polygon-containing vector object that has a stan-
dard attributes table (polystats).

Pinmaps can also have a Z component provided by
any field in the same table.  You can use this
value to float the points over the surface.  You
can connect these floating points to the sur-

face by adding
the pinmap a

s e c o n d
time and

using narrow
rectangular sym-

bols with a Y Scale tied to the same field.  (Symbols
are billboards and have no Z scale.)  Although this
effect can be created from a database pinmap, it is

done more eas-
ily and versatily
using vector
points (connect-
ing line can use a
variety of line
styles instead of
a single symbol).

STEPS

click on the Open
icon on the Display
Spatial Data toolbar,
choose Open Group, and
select BASINSANDSOILS

from the CENTROID Project
File

note how difficult it is to
determine which basins
(wide, orange outline)
contain soil polygons with
area >200000 m2 (filled)

click on the Hide/Show
icon for the CBSOILS_LITE

vector layer to
hide the layer

click Hide/Show icon for
the POLYDATA pinmap layer
to show the layer

click on the Database
Pinmap icon for the
pinmap layer and note
the settings in the
Pinmap Layer Controls

basins and soil polygons
(>200000 m2 centroids)

basins and soil polygons
(>200000 m2 filled)

soil polygons less than
200000 m2 are not filled

total
population



page 21

Pin Mapping

Pins to Vector Points for Theme Mapping
Pasting pins into an existing vector object as points
has been discussed.  This exercise describes import-
ing a database to create a new vector object for theme
mapping.  Importing points from a database table
eliminates the fluid properties of a pinmap that allow
pin movement by simply changing coordinate val-
ues in the table.  A theme map equivalent to that
created interactively for vector points  can be gener-
ated for a pinmap by script, but writing such a script
is rather tedious.  Creating a 500 point vector object
by import takes only about two seconds for the
import and less than a minute to set up.  Interactive
theme map setup is also very quick.

You then need to consider the source and use of the
data to decide whether query writing or import is the
best choice for you.  If the data is dynamic with pin
positions frequently changing, you should probably
write the appropriate query.  If the data is static with
pin positions based on past observations, import is
likely the way to go.

STEPS

choose Process / Import/
Export, set the option
menus to Vector and
Import, and double-click
on Database in the list of
formats

set the Database Format
to RVC Database Object,
click on [Database] and
select ARTIFACTS from the
GSPINMAP Project File

click on [Table] and click
[OK] in the Select
Subobject window

click on [Projection] and
choose UTM Zone 16

click on [X Column] and
choose EASTING (Y
Column should be set to
NORTHING), then click
[Import] and name the
new object in the GSPINMAP

Project File ARTIFACTPOINTS

open a new 2D group in
Spatial Data Display

click on the Add
Vector icon, choose
Add Vector Layer, and
select ARTIFACTPOINTS

click on the Points tab,
set the Style to By
Theme, and click on
[Specify]

choose the DATABASE table
and FREQUENCY field, then
click [OK]

open the Style Controls
panel, turn on the Spread
Size toggle, and set the
spread from 1 to 3 mm at
Layout Scale

choose Theme / Save,
accept the defaults, then
choose Theme / Close
and display the object

Accept the
defaults in
the upper
portion of
the Theme
Mapping
Controls
window.

Compare this depiction of the
artifact data points with the
versions presented on pages
6 and 7.
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More About Labeling
Designating label position from the option menu on
the Symbol panel was described on page 9.  You can
also specify label position in the script, which lets
you vary the position according to other pin at-
tributes.  The label position is specified by including
“LabelPosn” in the script and assigning a value from
1–9.  The values are in a 3 X 3 grid as shown, such

LabelPosn=1
LabelOffset=7
LabelAngle=90

LabelPosn=2
LabelOffset=5
LabelAngle=20

LabelPosn=5
LabelAngle=-45

LabelPosn=7
LabelOffset=5
#LabelAngle=90

STEPS
click on the New
2D Group icon

click on the Add
Database Pinmap
icon and select the
SCHOOLS object from the
GSPINMAP Project File

click on [Styles] and
select STYLEPINS from the
same Project File

check that the Symbol
option menu is set to All
Same and that the Point
Type is specified as Point
Symbol with school_p as
the selected symbol

click on the Script tab and
enter the query below in
the Query Specification
panel

click [OK] and observe
the result

return to the Pinmap
Layer Display Controls
window and modify the
query  to match the
second example below

click [OK] and observe
the result

try each of the four
examples and any other
permutations you’d like

LabelPosn=2
LabelOffset=5
LabelAngle=20

1  2  3
4  5  6
7  8  9

that a value of 5 positions the label centered
over the pin, 1 positions the label above and to
the left of the pin, and so on.

Two additional terms can be added to a script to
modify the position of pinmap labels: LabelOffset

and Label
Angle.  The di-
rection for la-
bel offset is de-
termined by the
label position.
Labels above

the pin are moved up, labels to the right of the pin are
moved further right, labels positioned diagonally
from the pin are moved the specified offset distance
in the two appropriate directions, and so on.  The
offset you specify is from the pin location to the
beginning of the label in the same units as the
symbol size, which means the offset must be at least
half the symbol width or the label will cover part of
the symbol.  Unrotated labels without specified
offsets do not collide with their associated symbols.
Add a LabelAngle assignment to the query to set
label rotation.  Rotation is specified in degrees anti-
clockwise around the label position.

When you want to remove a statement from a query,
you can either delete the text (bottom right) or you
can comment it out by placing a # at the beginning
of the line (bottom left).  (Other SML conventions
also apply.  See the tutorial booklet entitled Writing

Scripts with SML.)
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The last used display parameters for a database
pinmap are saved with the database object for use as
defaults the next time the database is selected for
pinmap display.  These display parameters include
the settings of all buttons and fields in the Pinmap
Layer Controls window and any entered query state-
ments.  When multiple pinmap layers of the same
database are used in a single layout, as in the Symbol
Angle and Multiple Pins exercise on page 8, these
multiple display parameters for a single database
object can be saved as a group or layout.  The display
parameters for the last added pinmap layer will be
the ones retained for the next time the database is
selected as an individual pinmap layer, while all the
different parameters will be used to recreate the
initial display when the layout is opened.

You can save any entered pinmap script for later use
with the same or other database objects by choosing
Query / Save from the menu bar in the Script panel
of the Pinmap Layer Controls.  Obviously, any field
names in the script would have to be the same across
objects for an unmodified script to work with an-
other object.  You can always use one script as a
model for the next, changing field names and map
scales as necessary.  You will get a syntax error in the
query if you forget to modify all field names to match
the currently selected database.

Further Notes on Pin Mapping

Don’t forget, if you find a
symbol you want that is a
character in a TrueType font,
you can easily use it with your
pin maps or vector objects.

All of these
symbols are found
in the STYLEPINS

style object in the
GSPINMAP Project
File.  Many more
are available in the
STYLE Project File
distributed with
TNT products (a
sample of these
symbols is shown
at the bottom left
of the page with
magenta as the
variable color).
Any of these
symbols or
symbols of your
own design can be
used with pin
maps or point
elements in vector
and CAD objects
and in the legends
you may include
when creating a
layout.

click on the Prefer-
ences icon, choose
View Options,  and
turn off the first option on
the View tabbed panel
(Redraw after any
change)

STEPS
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